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Introduction 

Welcome to the Alphatax UK Spring 2009 edition. This is a major release with many 

enhancements including: 

Á Finance Bill 2009. Changes including the introduction of 40% first year allowances, car 

allowances and new foreign currency loss rules.  

Á CTA 2009. Alphatax fully incorporates this first stage of the corporate tax law rewrite. 

Á Share pools. The way in which Alphatax handles share pool disposals has been 

substantially enhanced with the introduction of a new dedicated Share pool calculation. 

Á Significant enhancements to Accounts Analysis: 

Á Accounts Analysis users will no longer be required to complete the Fixed assets 

Input statement which can now be fully populated through the use of existing 

Accounts Analysis statements. 

Á Improvements to the Tax categoriser including keyword search capability. 

Á A major rewrite of the Group function, including: 

Á Introduction of functionality for long periods of account. 

Á A new function to allow group companies to be sorted in the group relief matrix 

subject to a number of criteria to aid tax efficient group relief allocation. 

Á Group annual investment allowance allocation and the introduction of additional 

summary reports. 

Á In accordance with the simplification of the HMRC regime for Real Estate Investment 

Trusts (REITs), we have revised Alphatax to deal with a REIT company in the same 

manner that you would any other company. We have provided a tool which will convert 

existing divisional files to stand alone company files. 

Á Accounts Integration. AI will accept data directly from Excel spreadsheets and will 

automatically consolidate multiple entries for individual ledger codes on import. 

Á Division Consolidation. Substantial changes include the ability to control divisional 

adjustments from the consolidated file and a new Divisional adjustment Summary view 

to provide details of all adjustments in a file. 

Á A new Batch print function. Users can choose to print computations, CT600 returns, or 

both, for a selection of companies made from the Admin summary or CCM window, 

including those from a group. 

Á Numeric formulae are now stored in input cells from Input and Accounts Analysis 

statements as well as Freeformat statements. This enables users to retain details of how 

an amount was calculated. 

Á It is now possible to attach a footnote to an Input statement that is shown in the 

corresponding Report statement 
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Á E-filing enhancements including the introduction of a new TCSLmark facility to ensure 

file consistency in electronic communications. 

Á Numerous other enhancements including changes to Tax Accounting and Tax Pack. 

Note. Alphalife and Alphacap have been updated with the relevant Finance Bill 2009 

changes and other enhancements. For details, refer to the Alphalife and Alphacap Release 

Notes for Spring 2009. 

Installation 

To update your existing version of Alphatax, simply insert the Alphatax Installation CD and 

press the enter key at the prompts. This will overwrite the old version of Alphatax. Enterprise 

users must also upgrade the Enterprise database as described on the following page. 

Note. You may be prompted to enter the 16 digit Alphatax Installation Key.  The Key is 

attached to the CD jewel box. Enter the key and then click Next.   Not all installations 

require an Alphatax Installation Key. 

Templates 

The installation will reinstall the standard Alphatax templates to ensure that you have the 

latest version.  

To allow you to retrieve your own versions of these templates, if applicable, the old 

templates are stored in a new folder called BACKUPKn (where n is a number incremented 

for each new installation). Note that this part of the process may take some time. A progress 

bar displays the names of templates as they are as they are being copied. 

Folders called BACKUPJn created in the Autumn 2008 release are removed with this release. 
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Enterprise only  

You must update the Enterprise database using the Alphatax Enterprise Manager before 

running Alphatax. If you do not update the database, an error message is displayed when you 

open Alphatax. 

To update the database, open Enterprise Manager and: 

1. Double-click the System Administration item in the Contents list. 

2. Double-click the Upgrade Alphatax Database item. 

3. Connect to the database for SQL Server or Oracle as appropriate. 

 

The Database drop-down list is a list of all the Alphatax databases on the selected 

server. The corresponding Status gives the version number of the database. For 

Spring 2009, the version number is 19. You must apply the upgrade if the Status 

shows a version number earlier than 19. 

4. Choose Upgrade Now for Alphatax Enterprise Manager to upgrade the database. 

For further details refer to the Enterprise Manager Administrator Guide which is located in 

the Manuals folder on the installation CD. 

E-Filing 

E-Filing is set to become a mandatory requirement for all companies for corporation tax 

returns filed after 31 March 2011 in respect of accounting periods ending after 31 March 

2010. Subject to the current HMRC timetable, we intend to have a version for field testing 

later this year and a fully operational release next May 2010. For more details of our future 

online filing strategy please see our web site. 

TCSLmark 

A new TCSLmark facility has been introduced to provide confirmation that the return sent to 

third parties for approval is the same return which is submitted to HMRC. The TCSLmark is 

generated and printed on the cover pages of the computation and the CT600 form prior to 

approval and will be regenerated prior to submission. Alphatax compares this with the 

original to identify whether any changes have been made which affect the tax return. This 

feature is enabled by the GenerateTcslMark  setting in the tcslbase.ini file. For details 

refer to the online Help. An override setting is also available allowing users to continue with 

an efiling submission even though the submission has been emailed to the client and the 

TCSLmark does not match that emailed to the client.  

E-Filing online Help and extended diagnostics 

E-Filing online Help has been extended and the process is now supported by additional 

diagnostics to ensure that the computation contains all appropriate information for e-filing 

purposes. The new diagnostics can be suppressed in a company file by using the Suppress e-
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filing diagnostics? option in the Configuration options Input statement if the company is not 

e-filing. 

A significant number of e-filing submissions currently fail due to error message 9198: 

Accounting Period details don't exist for this taxpayer. This is because the Accounting 

period start and end dates as entered in Alphatax and as held by HMRC do not match. We 

advise that before e-filing, you should check the dates held by HMRC and ensure that these 

dates are recorded in the Accounting period start date per HMRC records and 

Accounting period end date per HMRC records fields in the Return details Input 

statement under the Administration section of the Alphatax Contents tree. 

We have a continuing dialog with HMRC on their e-filing rules and requirements. Following 

feedback from TCSL, HMRC have agreed to amend the requirements for error message 9198 

to produce an error only where there are no days in common between the accounting period 

and the period noted in the company’s CT603. When HMRC introduce this change to their 

live server the instance of this error should decrease considerably. 

Miscellaneous E-Filing enhancements 

Á When emailing details of the submission to a client, the computation and associated files 

are now sent as a zip file. 

Á We have made a minor revision to the rounding of the marginal relief calculation 

following discussions with HMRC. 

Á If you wish to advise HMRC of a change of company address set the Address for this 

period differs from that held by HMRC? flag to Yes and the relevant information will 

be passed to HMRC as part of the e-filing process. 

Á The E-filing statement in the Compliance process section of the Contents tree can now 

be displayed in Report mode and printed via the Displayed statement Print option from 

the File menu. 

Legislative tax changes 

Finance Bill 2009 

Emissions based changes to car allowances 

Capital allowances 

For expenditure incurred from 1 April 2009, cars with CO2  emissions of between 110 g/km 

and 159 g/km qualify for WDA at 20%. Expenditure should be entered in the new 

Expenditure on cars qualifying for WDA at 20% pa field in the Plant and machinery main 

pool Input statement. 

Cars with emissions less than 110 g/km continue to qualify for FYAs at 100%. Expenditure 

should be entered in the existing Expenditure on which FYAs at 100% are claimed 

(excluding designated environmentally friendly P&M) field in Plant and machinery main 

pool Input statement. 
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Expenditure on cars with emissions of 160 g/km and above should be entered in the Special 

rate pool input statement via the Expenditure on cars qualifying for WDA at 10% pa field. 

Existing expensive cars 

Any cars in the existing expensive cars pool will continue to be treated under the old rules for 

a five year transitional period. 

At the end of any accounting period straddling 1 April 2014 any balance in the expensive 

cars pool will be automatically transferred to the general pool (regardless of the CO2 

emissions). 

Leased car deduction 

For new leases entered into from 1 April 2009, a uniform fixed percentage disallowance of 

15% is applied to leasing payments for cars with CO2 emissions of 160 g/km and above.  

A flag is available to denote where the CTA 2009 s56 disallowance does not apply (for 

example, where the CO2 emissions are below 160 g/km). 
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40% first year allowances 

A 40% first year allowance can be claimed for expenditure incurred between 1 April 2009 

and 31 March 2010. This FYA is available to companies of all sizes. 

Claims for expenditure can be entered via the Expenditure on which FYAs at 40% are 

claimed (disposed of in the period) and Expenditure on which FYAs at 40% are claimed 

(not disposed of in the period) fields on the Trade and Non-trade Plant and machinery main 

pool Input statements or via the Expenditure on which FYAs at 40% are claimed field on 

the Trade and Non-trade Short life assets Input statements. 

Relevant additions to Plant and machinery or Short Life Assets are included as qualifying 

expenditure in the Annual Investment Allowance Input statement. 

Note. This FYA is not available for expenditure on cars which instead attract a 20% WDA in 

the main pool, or for expenditure incurred by ring fence trades which continue to attract 

100% FYAs. 

Foreign denominated losses 

As announced on 18 December 2008, for periods beginning on or after 29 December 2007, 

companies that compute their corporation tax profits in currencies other than sterling can now 

carry forward or back any unused losses to offset future or past profits in those currencies 

instead of sterling (subject to the transitional rules). These changes affect the following 

statements in the computation: 

Á Trade Losses Input and Report statements 

Á Excess management expenses Input and Report statements 

Á Non-trade financial losses Input and Report statements 

Á Carried forward amounts Report statement 

A new Foreign currency accounting section in the Configuration options Input statement 

enables users to set the spot FX rate for day 1 of the first accounting period beginning on or 

after 29 December 2007 where a para 13 election is not made. An input on the Trade Losses 

Input statement enables users to enter the equivalent spot FX rate for the trade where trade 

currency differs from company currency. 

In the first period beginning on or after 29 December 2007, losses brought forward will be 

displayed in sterling. Losses carried forward will be shown in currency. In Report mode, 

Alphatax will display loss brought forward amounts in both sterling and the foreign currency 

with a note describing the exchange rate used. In subsequent periods, amounts will be shown 

in the foreign currency only. 
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Elections under FA 2009 Sch 18 para 13 

The Foreign currency section on the Configuration options Input statement enables users to 

make an election under para 13 to apply the changes for accounting periods beginning on or 

after the day on which the Finance Act receives Royal Asset. In this case, the election must 

be made before the end of the period of 30 days beginning with the first day of the first 

accounting period of the company beginning on or after the date of Royal Assent. 

It is anticipated that the date of Royal Assent will be in July 2009 and a provisional date of 

21 July has been assumed in this version of Alphatax which will be updated in the Autumn 

edition following Royal Assent. 
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Under the election, Alphatax maintains a separate sterling loss pool (for old losses) and a 

currency loss pool (for losses arising in periods starting on or after the date of  Royal Assent). 

Where the FA 2009 foreign denominated losses election - sterling based excess b/f 

utilised in period field is displayed, you should enter sterling-based losses that are being 

used within the calculated loss offset. The currency amount carried forward will be 

automatically reduced accordingly. In Report mode, a new Sterling based losses brought 

forward under FA 2009 Sch 18 para 13 election section is added to the foot of the report 

showing any: 

Á Loss brought forward in sterling 

Á Sterling based trade losses utilised in period 

Á Losses carried forward in sterling 
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Corporate Tax Act 2009 (CTA 2009) 

Alphatax fully incorporates the first stage of the corporate tax law rewrite following the 

enactment of CTA 2009.  

The following changes have been made: 

Schedular references 

References to Schedules and Cases (e.g. Schedule D Case I) in all Input and Report 

statements will be replaced by the appropriate CTA 2009 terminology for periods of account 

ending on or after 1 April 2009. The following table describes the changes to schedular 

references. 

Former designation CTA 2009 equivalent 

Schedule A UK property business 

Schedule D Case I Trading profits 

Schedule D Case III non-trade financial 

profits 

Non-trade loan relationships 

Other Schedule D Case III Miscellaneous income – non-trade financial 

profits 

Schedule D Case V – Overseas income Miscellaneous income – overseas 

Schedule D Case V – Overseas property 

business 

Overseas property business 

Schedule D Case V income – Trade Overseas trading income 

Schedule D Case VI income Miscellaneous income 

Legislative references  

Report statements will display the new legislative references where the company’s period of 

account ends on or after 1 April 2009. Legislative claims apply on an accounting period 

basis, therefore where a company file consists of two accounting periods that straddle the 

date of the change reports will display both the CTA 2009 and pre-existing references. 

In Input statements legislative references will be replaced by the appropriate CTA 2009 

terminology where both the period of account and all accounting periods contained within it 

end on or after 1 April 2009.  

In order to aid users and to ensure that Input statements remain concise, Alphatax will only 

display a single reference in the Input statements at any given time. Where a company file 

contains two accounting periods and straddles the date of the change the pre-existing 

legislative reference (only) will be shown in the Input statements. 

Our online Help system has been updated to include links to the Lexis Nexis Butterworths 

online tax reference service for CTA 2009. 
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Next year will see the publication of the second phase of the Corporate Tax law rewrite, 

consisting of CTA 2010 and the Taxation (International and Other Provisions) Act 2010. 

Alphatax will include all relevant revisions in a future release. 

New forms 

SA700 (2009) Non resident company return 

The SA700 (2009) return is now available in Alphatax. In addition to date and address 

changes, descriptions have been changed for Box 2.18, 2.52, 2.53 and 2.56 to introduce the 

new Annual investment allowance. Boxes relating to subcontractors in the construction 

industry have been removed. The limit for payments on account has been increased to £1000.  

Other changes for non resident companies are covered on page 23. 

64-8 

A revised form 64-8 is now available. This form is automatically completed by Alphatax 

based on entries in the company file. The return can be produced via the Letter Writer 

function or it can be e-filed via the Online Agent Authorisation option from the Tools menu. 
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Capital allowances 

Annual investment allowance 

The Annual investment allowance (AIA) Input statement will display in the Corporation tax 

computation section of the Contents tree in all Alphatax files regardless of whether they 

contain relevant qualifying expenditure. A note has been added to advise which categories of 

expenditure are included in the definition of ‘qualifying expenditure’ for the purposes of 

claiming AIA. When relevant expenditure is included in the computation AIA allocation 

input cells are made available. 

The AIA Input statement has been updated to include additions qualifying for 40% FYAs 

introduced in Finance Bill 2009. The calculation is optimised to allocate AIA against 

additions in the same pool in the most tax efficient manner. 

Where a company is part of a group the maximum available annual investment allowance is 

determined with reference to a group limit. A new Group AIA statement has been added in 

our Group module (see page 38 for details) which allows control of the claim across a group. 

Individual Alphatax files include a note advising that the group implications of the AIA limit 

may need to be considered in that file. 

S343 transfers 

s343 calculations have been enhanced to deal with the situation where the transferor and 

transferee have different accounting periods and straddle a period where hybrid rates apply. 

Alphatax will calculate the allowances due to the transferee based on its accounting period. 

IBA, ABA and Hotel allowances 

Following changes in FA 2007 IBAs are being phased out over a four year period through a 

stepped reduction in the rate of allowances. Alphatax correctly applies this restriction but we 

have amended our calculations to take account of FA 2008 s85(8) which states that the tax 

written down value carried forward should be calculated as if the stepped reduction in rates 

had not occurred. 

Other assets 

The Other assets Input statement is now available in the Non-trade deductions section of the 

Contents tree as well as the Trade section. This provides additional flexibility for users 

claiming capital allowances in non-trade businesses. 

The Accounts analysis categoriser has been enhanced to include the different capital 

allowance types under unique headings and now posts the appropriate Y/N flag to any items 

created via this route. Further details are provided in the Accounts Analysis section on page 

32. 

Both calculations have been revised to allow users to fully disclaim Initial allowances where 

applicable. 
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Miscellaneous capital allowance changes 

A new flag in the Configuration options Input statement enables users to produce a formal 

short life asset election within the computation. The option is only available where SLA 

allowances are being claimed in the period. 

When a short life asset is transferred to the main pool Alphatax did not previously transfer 

the associated cost out of the short life asset calculations, preventing deletion of the short life 

asset item. This issue has been addressed in the current release. 

The title of the special rate pool statements in the Contents tree have been revised where the 

period straddles 1 April 2008 to display Long life / Special rate pool. 

Capital disposals 

Share pools 

A new Share pool Input statement has been introduced to Alphatax for the Spring 2009 

release.  When creating a capital disposal, select the Share Pool radio button to create a set 

of share pool statements. 

 

Share pool calculations 

The new Share pool calculation Input statement can be used to keep track of share pool 

holdings across periods of account and to record details of any chargeable disposals. 

The main operative events input block accepts the details of any number of transactions 

relating to the share pool holding.  The Date, number of Shares and Amount of each 

operative event is recorded with a disposal being distinguished from an addition simply by 

the sign of the number of shares.  The Amount entered for an addition is the cost of the 

shares, and for a disposal, the Amount is the proceeds. 

Operative events may be entered in any order and will be sorted by date upon refreshing 

[F7]. 
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The share pool calculation filters the events between the 1982 Holding and the section 104 

pool and calculates the pool values after each event.  The complete calculations are then 

printed on a new Share pool calculation Report statement.   
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The details of any disposals are taken to a new Share pool Disposal Report statement which 

sets out the proceeds and costs of each disposal from the share holding in the period of 

account.  

 

The resulting chargeable gains and allowable losses then flow into the existing capital 

disposal calculations within Alphatax  

Additional aspects of each operative event can be captured in the Accessory statement. The 

contents of the Accessory statement flexes depending on whether the event is an addition or a 

disposal.  For additions, the Section 104 indexation allowance override field may be used 

to enter a section 104 pool value brought forward at a particular date.  Additionally, details of 

bonus and rights issues can be entered allowing Alphatax to automatically calculate the 

number and cost of shares to be added to the 1982 and section 104 pools. 
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For a disposal, the proceeds received can be reduced by entering the details of any Incidental 

costs of the disposal, of any Foreign tax suffered that is to be taken as a deduction, or by 

marking the disposal as a No gain/no loss transfer under TCGA 1992 s171, in which case 

deemed proceeds equal to total costs are taken.   

The gain or loss calculated may be restricted under the Substantial shareholding 

provisions, under the Depreciatory transaction provisions, or where the disposal is a 

deemed disposal upon an Appropriation of stock .  Additionally, the gain or loss on a 

disposal may be notionally transferred out, a chargeable gain may be postponed, and a loss 

may be set against other profits of the current and preceding periods under the Corporate 

Venturing Scheme provisions. 

The full calculation and details of any reliefs or restrictions are clearly disclosed on the new 

Share pool calculation, Share pool disposal and Postponed gain summary Report 

statements. Notes to the computation will also be printed when applicable and footnotes and 

review notes are fully enabled to further aid disclosure. 

Full details of the new statement and the function of the Accessory statement flags are given 

in the online Help.  

Capital disposals statements 

The main Capital disposals and the supporting Reliefs and postponed charges Input 

statements have been redesigned and streamlined for the Spring 2009 release.  The share 

inputs have been removed and the remaining capital disposal inputs have been reordered and 

renamed where appropriate.  The groups of inputs relating to each stage of the capital 

disposal calculation are now more clearly defined. 

Following the statement level footnote enhancement included in this release, the Additional 

note input has been removed from the Capital disposals Input statement.  A footnote may 

now be attached to the statement and this will appear as a note at the foot of the Capital 

disposals Report statement. 
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Other capital disposals enhancements 

Á A new Adjustment to gain/(loss) repeatable input block has been added to the Capital 

disposal statement.  The adjustment(s) entered will appear at the foot of the capital 

disposal calculation against the inputted description and will increase or decrease the 

chargeable gain or allowable loss as appropriate. 

Á Where chattels are part disposed, for computations beginning on or after 1 April 2008, 

Alphatax checks to see if the consideration plus market value of the part retained is less 

than £6,000. If so, the chargeable gain is reduced to zero as per TCGA 1992 s262 (5). 

The Capital disposal Report statement has also been amended to reference the legislation 

where the disposal is exempt and some part of the asset has been retained.  

Á The Summary of rolled over gains Report statement has also been revamped.  Gains 

rolled over will now appear listed under the specific headings of the legislative section 

under which the claim is being made and where the formal claim is made within the 

computation, the claim narrative will include the appropriate legislative references. 

Á In response to user feedback, a capital disposal calculation will now be produced where 

proceeds only are entered, with no associated costs.  In previous versions, the gain would 

simply be returned on the Chargeable gains summary Report statement. 

Tax changes for specific company types 

REITs 

When Real Estate Investment Trusts (REITs) were introduced in FA 2006, HMRC required 

both the tax exempt and residual companies to file individual returns. Alphatax used special 

REITs consolidated computations to handle this requirement, whilst providing comfort that 

the consolidated company position was correct. 

However since then HMRC has simplified the REITs regime with the result that the tax 

exempt company is rarely required to file a return. We have revised Alphatax to deal with a 

REIT company in the same manner that you would any other company. We have provided a 

tool which will convert existing divisional files to stand alone company files (details below). 
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In the Type of company section on the Standing data Input statement, specify whether the 

REITs company is:  

Á C (tax-exempt). Gains will not be chargeable and profits will not be charged to 

corporation tax. Note that there is no requirement for you to file a return for C (tax-

exempt) although you may wish to prepare a computation in Alphatax for the purposes 

of the REIT ratio calculations. 

Á C (residual). Profits will be charged to corporation tax without reference to the small 

companies rate of tax (ICTA 1988 s13) 

For REITs C (residual) companies where the Not preparing exempt company files? flag is 

set to Yes in the Configuration options Input statement, columns are made available in the 

following statements for the C (residual) computation that enable you to record data relating 

to the exempt computation: 

Á REIT ratio calculations 

Á Profit and loss 

Á Group function - REIT group financial statement 

Á Group function - Profits statement 

Converting existing divisional computations into standalone Alphatax files 

Note: First roll forward existing divisional files into an accounting period ending on or after 

1 April 2008 but before I October 2009 using Alphatax v9.5.  

When you open the consolidated computation in the Spring 2009 edition of Alphatax (v 10), 

the REITS Upgrade dialog enables Alphatax to create two new companies with just the 

brought forward entries from the divisional files. 

The computations for the C (tax-exempt) and C (residual) files must be consolidated prior 

to the upgrade process. The upgrade process will create two new files for the C (tax-exempt) 

and C (residual) companies with the [New REITs] marker appended to the name of the files. 

After the Upgrade has been performed the original consolidated file is user locked.  

Note. Certain non-trade brought forward data will need to be entered manually in the new 

REITs file created by the upgrade process. 

REITS Group changes 

The existing REIT group financial statement section has been modified to enable an input 

column where the company chooses not to prepare Exempt calculations in Alphatax. 
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Other REITS changes 

Á The existing profit and loss account and ratio calculations have been modified to allow 

the Exempt information to be collected in C (residual) if users are not using Alphatax to 

prepare exempt calculations. 

Á A new report has been introduced to display the chargeable gain/ loss and the loss carry 

forward for the purposes of the PID calculation. 

Á We have amended the report display for non-trade loan relationships to remove the text 

Adjustment to NT LR Dr arising from REITS C (tax -exempt) business on 

consolidation where this did not apply. 

Oil ring fence companies 

Á The double tax relief calculation has been enhanced to ensure that non ring fence 

deductions are not allocated against ring fence profits for the purposes of ICTA 1988 

s797(3). 

Á Ring fence trade charges are now set off against ring fence profits (previously these were 

allocated to non ring fence profits) 

Á A new flag has been introduced to the Trade loan relationship debits Input statement to 

flag a debit allowable for ICTA 1988 s 501A(5) purposes (the supplementary charge 

calculation). 

Á An issue where supplementary charge losses carried forward omitted the current period 

ring fence profits in some instances has been resolved. 

Á Some presentation improvements have been made to the Supplementary charge Report 

statement. 
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Non resident companies liable to income tax 

Á To reflect changes to the new form SA700, new input boxes have been added to the 

Non-resident company property income Input statement that accept details of the capital 

allowances and balancing charges that relate to the Annual investment allowance and 

to Allowances at 10%.  Inputs relating to fields that are no longer used on the form have 

been removed. For further details refer also to page 14. 

Á Translation mode is now fully enabled for non-resident company returns for 2008/09 and 

subsequent periods.  When translation mode is enabled, the trade level Non-resident 

company property income Input statement will accept currency inputs which will be 

reported on the Non-resident company property income and Non-resident company 

furnished holiday lettings Report statements.  The income and losses will then be 

automatically translated to sterling at the specified rate and included on the summary 

Income tax for non-resident companies Report statement and on the form SA700. 

Á The loss relief deducted from general income as sideways relief is now automatically 

restricted to the lower of the property loss available, and the net capital allowances after 

balancing charges, as per 2007 ITA s120.  A new input has also been included to claim 

carry forward loss relief against general income of the following year under the same 

section.  The loss entered will appear as a deduction on the Income tax for non-resident 

companies Report statement in the following year. 

Á The Other information inputs on the non-resident company Additional information Input 

statement have been made into a repeating inputs to ensure that any number of notes to 

the return may be entered.  The information will be printed in Box 10.1 of the form 

SA700 and the continuation pages if necessary. 

Á The income tax liability limit, past which payments on account are required to be made, 

has been increased from £500 to £1,000. 

Á The transposition of the company name onto the form SA700 has been amended such 

that longer names of up to 300 characters may now be entered. 

Á Finally, all references to Non resident landlords have been changed to Non resident 

companies in line with the narrative on the form SA700. 
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Miscellaneous tax changes 

Retail prices index and tax districts 

The RPI, interest rate and tax table file in this release includes changes up to the May RPI 

(212.8). The release also includes an updated tax district addresses file. 

You can download the RPI, interest and tax table file on a monthly basis directly from our 

website (http://www.taxcomputersystems.com/ rpi -and-tax-tables.html) to ensure you 

always have the most up to date figures. The file to be downloaded is TCSLCT.TBL and it 

should be copied to the main Alphatax program folder. 

You can also download the latest tax district addresses file (TCSLCT.DST) from the same 

location. 

Share scheme deductions 

A new Share incentive plan deductions Input statement enables users to record details of 

share incentive plan deductions under ICTA 1988 Sch 4AA.  

Foreign tax 

Á A note on the mixer cap on the Overseas income Input statement is now only shown 

when the mixer cap restriction applies. 

Á The rounding in the EUFT calculation has been revised to ensure that EUFT amounts of 

below £1 are appropriately recognised. 

Á Corrections have been made to the brought forward loss override for DTR purposes 

where the main trade has foreign tax. 

Pension scheme adjustments (FRS17/IAS19) 

A new Pension scheme adjustments Input statement is available within the Accounts 

Analysis section of the Contents tree. This enables users to capture the appropriate tax 

adjustments arising on pension schemes accounted for under either FRS17 or IAS 19. 
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Provisions analysis  

Alphatax now enables you to insert individual analyses for different provisions, nested under 

the main Provisions statement. The option is available for both trade and non-trade 

Provisions statements. 

 

Fixed asset changes 

Á Significant changes have been made to the Fixed Asset section of Alphatax for Accounts 

Analysis users. For further details see page 32. 

Á The Other line in the Fixed Assets Input statement has been amended to a repeatable 

row. Any number of analysis rows can be added to the statement to aid explanation of 

movements. 

Leasing 

Á The entire Lessor accounting section has been rewritten for Accounts Analysis users. For 

further details see page 32. 

Á Calculations performed in the Adjustment under Sch 12 FA 1997 statement have been 

significantly extended in scope. 

Á We have enhanced the display of the Lessor and Lessee long funding operating lease 

Input statements by embedding the name of the asset in the associated report titles. 
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Enhanced expenditure (R&D, VRR etc) 

Á Changes to the definition of an SME for R&D purposes included in FA 2007 s50 have 

been included and the note at the foot of the Small, medium or large Input statement has 

changed accordingly. 

Á HMRC have issued a Brief regarding what happens when an SME becomes large as a 

result of a merger, takeover or linking. From 1 December 2008, an SME will be regarded 

as large for R&D and VRR purposes for the whole accounting period in which the 

change occurred. 

Á Where an ECA claim is made the maximum surrenderable loss should be reduced by 

s393 loss available and group relief surrenders made and available. A new input Reduce 

maximum unrelieved trading loss available for ECA surrender by group relief 

surrender available [para 11 Sch 25 FA 2008] has been included in the trade loss 

statement to allow the available loss to be restricted accordingly. 

Computations using foreign currencies / round thousands 

Á We have enhanced the disclosure for the Trade Charges on income statement to better 

explain the offset of excess trade charges where a trade currency conversion is used. 

Á Where a trade was flagged as an overseas property trade, in rare instances the non-trade 

deficit b/f could be deducted twice in the Non-trade financial losses statement. This issue 

has been resolved. 

Á An occasional rounding issue between the management expenses inputs (in company 

currency) and CFC expense relief inputs (in sterling)has been resolved by introducing a 

new Management expenses [enter in company currency] currency input on the 

Controlled foreign companies Input statement. The existing sterling inputs have been 

preserved to retain consistency in existing files. Where a rounding error exists, delete the 

existing sterling entry and the new currency input will become available. 
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Other miscellaneous changes 

Á Existing configuration options have been streamlined to display only where appropriate 

conditions are met. 

Á A new List income and expenditure adjustments items on Accounts adjustment 

report? field on the Configuration options Input statement enables the Accounts 

adjustment Report statement to list income and expense adjustments by name.  

Á To facilitate claiming deductions for non P&L amounts, a blank column is now available 

on the Management expenses Input statement (after the Transfer column for non P&L 

amounts) with a customisable heading. 

Á Where a period of account straddles two accounting periods and the computation shows 

a payment in one period and a repayment in the other the text description will flex 

accordingly. 

Á Amortisation is disclosed in its own line (distinct from depreciation) in the accounts 

analysis adjustment statement for periods ending after 31 December 2008. 

Á We have enhanced the disclosure for new companies which are not therefore part of the 

Quarterly instalments regime. 

Á Where an investment company ceases trading, the excess management expenses can be 

eliminated under ICTA 1988 s75 via the new Expenses eliminated (enter 'yes') [may 

enter amount] field on the Excess management expenses Input statement. Note that this 

input is period-specific so that expenses can be eliminated in a second accounting period. 

Á A non-trade loan relationship deficit b/fwd can be set against any non-trading income or 

gain. There is no statutory precedence to the order of offset against different types of 

income or gains. Historically Alphatax has defaulted to offsetting the b/fwd losses 

against Non trade loan relationship credits. A Suppress b/f deficit amount set against 

loan relationship income, eg to maximise carry back capacity override has been 

added to the Non-trade financial losses statement in order to tailor the manner in which 

the loss is offset against relevant profits. 

Á We have resolved a display issue that occurred where equal and opposite adjustments 

were made in the NTLR debits and credits input for the UK to UK  column of the 

Transfer pricing adjustments Input statement. 

Á Problems with rounding differences on the Other assets statement have been resolved. 

Á Problems with reporting disallowed loss for disposal in a second period in a long period 

of account have been resolved. 

Á We have fixed an issue where the Non trade financial losses Report statement incorrectly 

included a translation mode note whenever an amount was brought back against loan 

relationship income in all instances, including sterling computations.  

Á Minor disclosure issues on the continuation page printout for Sch 23 Share Scheme 

deductions have been fixed. 

Á A new flag has been introduced on the Advanced corporation tax Input statement in the 

first Alphatax period in a file, to allow you to flag that the Final period for recovery of 
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surplus ACT under SI 1999/358 was in a previous period. This will ensure that all 

ACT-related inputs and reporting values are hidden in that period and all future periods. 

System changes 

Batch printing 

A new Batch print function enables users to print or PDF computations, CT600 returns, or 

both, for companies selected from the Admin summary or CCM window, including those in a 

group. Users can also select to print or PDF all periods within a computation. 

You can remove or add selected items using the Add Items and Remove Items check boxes.  

Use Select All  to select all items. If you then choose to tick or untick a Computation or 

Facsimile checkbox for one item in the batch, the change will be applied to all items. Use 

Unselect All to make changes to check boxes individually or to Remove All items from the 

list 

Select Print or PDF and then click the Setup button to define Print Setup or PDF options and 

then click Start when you are ready to print the batch or create PDF versions.  

While batch printing is in progress, users can close the dialog and continue with other 

Alphatax activities as normal, including printing.
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During processing, the symbol beside each item changes: 

 
Ready to print 

 
Printing or sending to PDF 

 
Completed 

The Batch Printing dialog remembers your settings throughout the current Alphatax session. 
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Miscellaneous system changes 

Á Numeric formulae can now be entered and retained in standard Input statements, 

including Accounts Analysis input statements. 

Á An orange bar now indicates field position within all Alphatax statements. The colour of 

the bar can be altered via the Tools – Options – Colour setup – Form highlight option. 

Á Footnotes can now be added to an Input statement at statement level as well as field 

level. Footnotes entered in this way are now shown at the foot of the relevant Report 

statement. 

Á The footnote editor has been enhanced. Pressing the Enter key now accepts the footnote 

and a carriage return is enabled through use of Ctrl  or Shift + Enter. 

Á Switching periods via the View menu now brings users to the same statement and mode 

(i.e. Report, Input, Compliance progress or Claims and elections mode) as the previous 

period, assuming the statement is available in both periods. 

Á We have introduced the ability to restart reference numbering in Report mode from the 

Corporation tax payments heading. This avoids inconsistency when diagnostics are 

removed from the computation via the Use CP reference box on the Page layout tab of 

the Options dialog. This is recorded in the PrintComplianceProcess  setting in the 

tcslbase.ini file.  

Á Paste special works from Excel 2007. 

Á When a period is user locked or unlocked the user must enter a comment, which is saved 

in the company Audit trail. 

Á The Print configure dialog is now available for use with  the Review notes Summary 

statement. 

Á The timed backup functionality has been enhanced to be more robust and further alert 

users to any potential backup problems. 

Á A new [PDF] section in the tcslbase.ini file enable users to set the Subject line: for the 

email where PDFs are sent (Email Subject = <text >) and to set the path where 

the PDF will be created (PDF File Location = <path> ) 



Alphatax Release Notes 

Spring 2009        31 

Tax Administration 

Enterprise only 

Alphatax can now detect if the Enterprise database does not match the tcslct.prg file 

(Compliance progress) when users select Email notification from the View menu in the CCM 

window and displays a warning message where this is so.  

The system administrator should amend the Email settings via the Enterprise Manager.  

If you have overridden the default responsibilities titles (in the Responsibilities and notes 

Input statement), a similar warning is displayed where the database does not match entries in 

the tcslct.dft file. Again settings should be updated via the Enterprise Manager. 

The number of columns in the CCM that can be linked to the Compliance progress Input 

statement has been increased from five to ten.  

The Select users, Select a nodes and Customise Columns dialogs in the CCM window can 

now be resized. 
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Optional modules 

Accounts Analysis 

Categoriser enhancements 

The Accounts Analysis Tax categoriser dialog has been enhanced to aid navigation with 

Expand/Collapse and Search options enabled. In addition a new path display has been added 

to provide a clear description of the current focus. 
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The categoriser has been amended to include specific categories for each of the ‘Other’ 

capital allowance types available in the Trade and Non-trade Other assets Input statements. 

The categoriser will automatically populate these statements with the appropriate Yes/No 

flag to identify the type of capital allowance being claimed. In addition, where you are 

making additions identified as one particular type of capital allowance, the categoriser will 

only display items that have already been categorised to that category of capital allowance. 

The categoriser has been enhanced to include additional user-definable column headings. 

These new options represent unlinked columns that allow users to insert their own 

descriptions and to choose where to link values. User-definable column headings are 

available on a company-wide level, a non-trade level and for individual trades. 

We have taken the opportunity to revise the ordering and descriptions of a number of the 

available options to ease navigation. 

Fixed asset changes 

Following user feedback, the Spring 2009 release has seen a complete rewrite of the fixed 

asset requirements for Accounts Analysis users. For periods ending after 31 December 2008, 

Accounts Analysis users are no longer required to complete the Fixed assets Input statement. 

The statement can now be fully populated via existing Accounts Analysis statements.  

For periods after 31 December 2008 the Fixed Assets Input statement will appear in the Tax 

accounting section of the Contents tree. The only input cells that will remain available on the 

new Input statement are those relating to brought forward amounts. All other inputs should 

be populated via the Accounts Analysis categoriser. 

PLEASE NOTE: The above change will occur by default in relevant files. Where you wish to 

continue to use the existing Fixed Assets Input statement in a particular file you should use 

the Display Fixed assets statement in the Balance sheet analysis section? on the Accounts 

analysis options Input statement. Choosing this option will revert the statements to the 

original configuration. 

 

Should you wish to revert the default behaviour back to the original configuration across all 

Alphatax files, this is possible by setting the PositionFixedAssetsStatement flag to 2 in the 

[SYSTEM] section of the tcslbase.ini file. For details on using this file, refer to the online 

Help. 

In addition to the above change a new Fixed asset summary Report statement has been 

introduced to replace the existing disclosure. This Report statement provides a summary 

which more closely mirrors the accounts and does not include any tax accounting 

information, which is wholly contained in the old statement displayed in the Tax accounting 

section of the Contents tree. 

The Tax categoriser has been extended to include the fixed asset entries that were previously 

available only on the Fixed Assets Input statement. 

A new Deferred expenditure Input statement has been provided in the Balance sheet section 

of Accounts Analysis. The statement is fully enabled for tax categorisation and further 

analysis. 
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Accounts Analysis has been enhanced to allow for negative net book values on the disposal 

of assets.  

Multi-column Profit and loss Input statement  

The multi-column Profit and loss Input statement is now available for all companies and not 

just those with more than one trade. 

Where the Use multi-column P&L?  flag on the Accounts analysis options Input statement 

has been set to Yes, one column per trade will continue to be displayed automatically. 

However, an additional non-trade column is now available with the option to include up to 

two more. 

Rounding issues have been addressed where individual trades were being translated at 

different rates in the multi-column profit and loss account. 

Lessor accounting 

The Spring 2009 release has seen a complete rewrite of the Lessor accounting statements 

available to Accounts Analysis users. 

Existing Input statements for Finance and Operating lease assets in the Lessor accounting 

section are replaced by Accounts Analysis statements for Finance lease receivables and 

Operating lease assets. Both these statements are fully enabled for tax analysis and 

categorisation and significantly increase the flexibility of Lessor calculations in Alphatax. 

Addition sub-analysis statements automatically restrict additions available for capital 

allowances in the period under CAA 2001 s220(1), allowing a portion of the cost to be tax 

categorised based on the date of acquisition in the period. Expenditure deferred for 

allowances in the period will be carried forward automatically. 

Miscellaneous Accounts Analysis changes 

Á We have resolved a display issue in the Profit and Loss account which led to an 

additional sub-total line displaying in some circumstances 

Á Diagnostics which advise where entries have been made in Accounts Analysis input 

statements and Accounts Analysis has been turned off have been amended to ignore the 

effect of brought forward values. 

Tax accounting 

Improving first time use of Tax Accounting in existing computations 

Following user feedback we have enhanced the manner in which Alphatax deals with first 

time use of the tax accounting statements in an existing Alphatax file. In previous versions of 

Alphatax, brought forward values could not be directly revised in order to ensure consistency 

between different periods. Where an existing file had not been used for tax accounting 

calculations brought forwards had to be adjusted to the correct opening position rather than 

allowing a blanket restatement of the opening position. 

The Spring 2009 edition of Alphatax significantly improves the use of tax accounting in 

existing files. A new First year that Alphatax is used for tax accounting? flag has been 
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introduced in the Tax accounting options Input statement. Setting this flag to Yes enables 

users to directly insert their own brought forward amounts. The option can be used in any 

period following the first and can be used in consecutive periods if this is required. 

The option affects brought forward entries in the following statements: 

Á Tax account summary 

Á Gross timing differences 

Á Fixed assets 

Improving Tax Accounting disclosures 

A new Provisions now finalised and ready to print? flag has been introduced on the Tax 

accounting options Input statement. Setting this flag to Yes modifies the Tax charge per 

accounts Report statement so that the Derived columns are removed and Current period  

and Previous period headings are converted to the relevant year. 

Sign conventions 

Following user feedback, we have enhanced the Tax accounting Input and Report statements 

to clarify the sign conventions being used for assets/liabilities and debits/credits. 
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Other Tax Accounting changes 

Á Two new configuration flags in the Tax accounting options Input statement enable users 

to switch from UK GAAP to IFRS and vice versa. 

Á The tax accounting diagnostics have been enhanced. 

Á The Analysis of prior period current tax Input statement has been improved by including 

automatic sorting based on the periods. Also, calculated values on this statement have 

been revised to refresh automatically without requiring an F7 refresh. 

Á The s36 FA 2007 adjustment has been revised to ignore the impact of the Suppress tax 

accounting reports? flag in all instances. 

Á A new Other column has been added to the existing Discount calculations. 

Á Where an adjustment was made to the brought forward TWDV of either trade or non-

trade intangibles, this was not previously recognised in opening the Gross timing 

differences for deferred tax purposes. The value is correctly recognised in this version.  

Á Alphatax will now automatically complete the opening currency conversion required 

where a trade changes from sterling to round thousands. 

IFRS tax accounting 

Á A number of presentational changes and additional checks have been made to the IFRS 

tax accounting statements in line with user feedback. In particular the reports have been 

improved. 

Á We have performed a full review of the IFRS diagnostics and made a number of 

improvements to the coverage and disclosure. 

Á An adjustments row has been added to the foot of the IFRS balance sheet to allow users 

to adjust the deferred tax charge to be booked in the accounts. 

Á Specific provisions now automatically feed through to the IFRS provisions statement. 

The carrying value and tax base are automatically included. 
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Group  

The Group function has seen a major rewrite to improve efficiency and ease of use. Although 

many changes are invisible to the user, you will notice: 

Á Input and Report statements have been extensively redesigned and are supported with 

additional diagnostic checks. Certain statements have been amended to display only 

where appropriate conditions are met. 

Á A separate Input statement is provided for Group relief configuration options. 

Á Improvements to the manner in which the Group module deals with long group periods 

and group reporting in foreign currencies. 

Á A number of enhancements to Group relief calculations. For further details, see below. 

Á A new statement has been provided to enable the annual investment allowance to be 

allocated between group companies. For further details, see page 38. 

Á A new section allows control of staff responsibilities across group companies. For 

further details, see page 40. 

Á Substantial improvements in the use of non Alphatax companies, including streamlined 

data entry and availability in existing statements. 

Á There are additional Report statements for Profit and losses and Capital allowances. 

Á In line with Alphatax company files an orange bar now indicates the position of the 

selected cell in both Input and Report mode. 

Á The Review note and footnote functions are now available in all Group statements 

including entries in the group relief matrix. 

Group relief calculations 

Group relief sorting 

A new Group Relief Sort Order dialog enables you to sort both claimant and surrendering 

companies by one of a number of criteria in order to ensure the most efficient allocation of 

group relief across the group members.  

The criteria on which group companies can be sorted for group relief purposes include: 

Á Effective tax rate 

Á AP start and end date 

Á Profits or losses 

Á Consortium % 

This option can be accessed from the Group relief Input statement via Statement ï Sort from 

the Alphatax toolbar. Sorting is accomplished independently from of the order in which 

companies are displayed in the Contents tree. Following completion of the group relief 

allocation you can revert the company order to that shown in the Contents tree by choosing to 

sort by Group companies. 
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Other group relief changes 

In addition to the group relief sorting changes the Loss allocation Input statement has been 

enhanced to provide additional details of the over/(under) allocation of loss surrenders. 

Additional columns have been added to the existing Payments for group relief Input 

statement to capture details of the actual payment made and the difference between this and 

the calculated payment. 

Group Annual Investment Allowance 

A new statement has been included to provide a mechanism to allocate the AIA between the 

companies making up a group. 

Using the statement 

The new statement is included in the Reports section of the Group contents tree. The 

statement will only display where any group companies include relevant expenditure. 

In order to allocate AIA between company files you must first set Use group AIA allocation 

in company files? to Yes. This will enable the AIA allocation  column through which AIA 

can be allocated to individual companies. An entry in this column will post a total amount to 

the company file.  

This AIA allocation from the Group module must then be allocated to specific pools in the 

company file using the Annual investment allowance Input statement. Where this step has not 
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yet been performed a diagnostic message will appear in the group advising that the amount of 

AIA allocated to the company file has not been used in that file. 
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Group AIA capacity 

Under FA 2008 Sch 24 para 51C(1) a group of companies is entitled to a single annual 

investment allowance between them in respect of the relevant AIA expenditure. The relevant 

AIA qualifying expenditure is the AIA qualifying expenditure incurred by the companies in 

chargeable periods ending in the relevant financial year.  

An Alphatax group file provides a default limit based on a single financial year. However 

each company accounting period includes data advising in which Financial year the 

accounting period ends. If you wish to allocate more than a single Financial year limit from a 

single Alphatax file you can do so by using the Override input cell to increase the Group 

capacity accordingly. 

Qualifying expenditure 

The group AIA statement automatically displays all qualifying expenditure included in the 

company files. The total qualifying expenditure is displayed by default but can be further 

analysed between relevant pools (such as Special rate pool and Plant & Machinery for 

instance) using the Display analysis of qualifying expenditure? flag. This information 

enables AIA to be allocated to those companies that can make the most efficient use of the 

allowance. 

Analysis of how AIA has been allocated in company files 

The Display analysis of AIA used? flag enables a review of the manner in which the AIA 

limit has been allocated between different pools in company files. The information enables 

users to confirm that AIA has been allocated in the most efficient manner in the company 

files. 

Non Alphatax companies 

Details for non Alphatax companies can be entered directly onto the statement using 

specifically provided inputs. 

Group control of company responsibilities 

Following user feedback we have enabled staff responsibilities to be controlled directly from 

a group file. A new Group responsibilities section has been added at the base of the 

Standing data statement. Check the Override company data? flag against the relevant 

staff level and enter details of the new staff member in order to post this information to all 

company files. Groups are now included as well as companies when users are flagged via the 

Selected users dialog  in the CCM window (Enterprise only. 
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Capital allowances report 

Existing capital allowance data has been removed from the Profits Report statement into a 

standalone report. The new report provides details of the tax written down values brought and 

carried forward for the different pools held by group companies. In addition it provides 

details of both the maximum available WDA and the amount of WDA claimed in the 

company files. 

Information can be included for non Alphatax companies through the use of specific input 

lines on a company by company basis. 

Miscellaneous Group changes 

Á The Tax charges (derived) and the Overall proof of tax Input statements have been 

streamlined to display relevant lines only. A flag is provided in each case to enable the 

display of all lines regardless of entries in Alphatax company files, for instance where 

you are introducing values for non Alphatax companies. 

Á The online Help for Group has been expanded to include additional details on how to set 

up and maintain group files. 

Á We have undertaken a full review of data that is carried forward into subsequent group 

periods. Following this review additional data is now carried forward into new group 

periods. 

Á The Profits Report statement has been rewritten, including changes to the display of 

excess management expenses brought forward. 

Á Where a NTLR deficit has been offset against other company profits this will no longer 

appear as being available for group relief. 

Á In the Payments for group relief Input statement the Pay all at same rate input cell has 

been amended to accept inputs to two decimal places. 

Á REITS. The profit and loss consolidation statement in group has been enhanced to 

provide inputs for C (tax-exempt) companies where the user has chosen to not produce 

Alphatax files following the change in HMRC’s filing requirements for this type of 

company. 

Á We have fixed an issue on the Group membership Input statement where the report 

disclosure of certain Yes/No items was inconsistent with the Input statement. 

Á A display issue affecting the inclusion of the Transfer Pricing report when only UK-UK 

entries were included has been resolved. 
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Division Consolidation 

You can now make adjustments to divisional values within the main computation. 

 

A new Divisional adjustments Summary view is available in the Compliance process section 

of the Contents tree. This tracks adjustments made to divisional values and allows users to 

navigate directly to the statement involved.  
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Divisional adjustments can be exported to Excel via an option from the right mouse-click 

menu when the statement is highlighted in the Contents tree. The notes and their responses as 

ticked in the Export  column are generated in a new Excel worksheet.  

Where the Divisional Adjustments background option in the View menu has been ticked, 

any cell where an adjustment has been made will have a yellow background. Colours can be 

reset via the Colour tab from the Options dialog on the Tools menu. 

Where Accounts Analysis is in use and Analysis statements for inter-divisional transfers in or 

out have been created in the divisional computation(s), you can view these statements in the 

main computation if the Inter -divisional statements option is ticked in the View menu. 

Exporting and importing divisions to and from different locations has been improved. 
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Accounts Integration 

The Accounts Integration function now allows the importation of data from an Excel 

worksheet without the need to convert files to CSV format. 

Alphatax now consolidates multiple entries for individual ledger codes on import 

In addition data can now be posted at transactional level into prepared Freeformat statements. 

To do this, choose the Config button on any of the Accounts Integration Setup tabs to display 

the Additional Configuration detail dialog. 
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Use the Additional configuration dialog to define mapping for transaction level items to be 

mapped to Freeformat statements. 

1. In the Pre Transaction Spacing box, specify the number of lines to be used for 

headings. 

2. In the Total Transaction Lines, specify the number of lines to be made available 

for transactions. If there are more transactions than allowed for here, they will not be 

imported but this will be included in the Import balances audit trail report. 

3. Specify the which column is to be the Description Column - e.g. 1 

4. Specify the Value Column - e.g. 3 

If you are importing from Excel, the name of the worksheet is shown at the foot of the dialog. 
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Tax Pack  

The Excel Tax Pack has been enhanced to reflect the major changes to Alphatax as well as 

other enhancements and bug fixes. 

Á The Main Provisions statement has been redesigned and now includes a Provisions 

analysis section. Use this section to create a Provisions list for further analysis via the 

new Provisions analysis schedule. Use the Categoriser to assign items on this schedule to 

items in the Provisions list. Totals are then assigned form the Provisional analysis 

schedule to the appropriate item in the Provisions list on the main Provisions schedule. 

Á Other new schedules include: 

Á Pension scheme adjustments to enable appropriate information to be captured for 

FRS17 and IAS 19 tax adjustment calculations. 

Á SIP deductions to record details of share incentive plans. 

Á Leased cars (post April 2009) to reflect that car allowances are now based on CO2 

emissions. 

Á Handling of capital disposals has been enhanced with a new March 82 input added to the 

Capital disposals schedule and a new Rollover amount added to the Capital disposals 

costs schedule.  

Á To reflect changes in Alphatax a new column with a customisable heading is available 

for non P&L amounts in the Non trade Investment company management expenses 

schedule. 

Á Text boxes can now be imported or exported on a sheet by sheet basis. 

Á The order of Accounts Analysis statements in Alphatax is now replicated in Tax Pack 

even where these have been re-ordered prior to export. 

Á All Accounts Analysis statements now export with a minimum of five blank rows.  
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